
 

 Program STEEL NTC-DF © 2013 Dlubal Software GmbH 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Add-on Module 

STEEL NTC-DF 
Ultimate Limit State, Serviceability 
and Stability Design According to 
NTC-RCDF 2004 

Program 
Description 

Version 
September 2013 

All rights, including those of translations, are reserved. 

No portion of this book may be reproduced – mechanically, electronically, or 
by any other means, including photocopying – without written permission 
of DLUBAL SOFTWARE GMBH. 
 
 
©  Dlubal Software GmbH 
Am Zellweg 2    D-93464 Tiefenbach 
 
Tel.: +49 9673 9203-0 
Fax: +49 9673 9203-51 
E-Mail: info@dlubal.com 
Web: www.dlubal.com 
 

http://www.dlubal.com/




 

 

 

3 

Contents 

 Contents Page 

 

 Contents Page 

 

Program STEEL NTC-DF © 2013 Dlubal Software GmbH 

1. Introduction 4 
1.1 Add-on Module STEEL NTC-DF 4 
1.2 STEEL NTC-DF - Team 5 
1.3 Using the Manual 6 
1.4 Open the Add-on Module STEEL NTC-DF 6 
2. Input Data 8 
2.1 General Data 8 
2.1.1 Ultimate Limit State 9 
2.1.2 Serviceability 10 
2.2 Materials 11 
2.3 Cross-sections 13 
2.4 Lateral Intermediate Supports 17 
2.5 Effective Lengths - Members 18 
2.6 Effective Lengths - Sets of Members 21 
2.7 Nodal Supports - Sets of Members 22 
2.8 Member End Releases - Sets of Members 24 
2.9 Serviceability Data 25 
2.10 Parameters - Members 26 
3. Calculation 27 
3.1 Detail Settings 27 
3.1.1 Ultimate Limit State 27 
3.1.2 Stability 28 
3.1.3 Serviceability 30 
3.1.4 Other 31 
3.2 Start Calculation 32 
4. Results 33 
4.1 Design by Load Case 34 
4.2 Design by Cross-Section 35 
4.3 Design by Set of Members 36 
4.4 Design by Member 37 
4.5 Design by x-Location 37 
4.6 Governing Internal Forces by Member 38 
4.7 Governing Internal Forces by Set of 

Members 39 
4.8 Member Slendernesses 40 
4.9 Parts List by Member 41 
4.10 Parts List by Set of Members 42 

5. Results Evaluation 43 
5.1 Results in the RSTAB Model 44 
5.2 Result Diagrams 46 
5.3 Filter for Results 47 
6. Printout 49 
6.1 Printout report 49 
6.2 STEEL NTC-DF Graphic Printout 49 
7. General Functions 51 
7.1 Design Cases 51 
7.2 Cross-Section Optimization 53 
7.3 Units and Decimal Places 55 
7.4 Data Transfer 56 
7.4.1 Export Material  to RSTAB 56 
7.4.2 Export Effective Lengths to RSTAB 56 
7.4.3 Export Results 56 
8. Example 58 

A Literature 65 

B Index 66 

 



1  Introduction 

 

 

 

4 Program STEEL NTC-DF © 2013 Dlubal Software GmbH 

 
 

Axis system 

1.  Introduction 
 

1.1 Add-on Module STEEL NTC-DF 

The Mexican standard (NTC-DF) describes the design, analysis and construction of steel struc-
tures in Mexico. With the RSTAB add-on module STEEL NTC-DF, DLUBAL ENGINEERING SOFTWARE 

provides a powerful tool for designing steel framework models. 

STEEL NTC-DF performs all typical ultimate limit state designs as well as stability and defor-
mation analyses. The program is able to take into account various actions for the ultimate limit 
state design. Furthermore, you can choose between the interaction formulae mentioned in the 
code. In accordance with the code, STEEL NTC-DF divides the cross-sections to be designed in-
to the cross-section slenderness types. In this way, you can check the limitation of the design 
capacity and of the rotational capacity due to local buckling for cross-section parts. Moreover, 
STEEL NTC-DF determines the c/t-ratios of the cross-section elements subjected to compres-
sion and classifies the cross-sections completely automatically. 

The axial system of members in STEEL NTC-DF is different from the indices used in the Mexican 
standard: The index of the longitudinal member axis “z” is denoted as “x” in the program; “y” 
and “z” refer to the axes in the cross-section plane as seen in the image to the left. 

For the stability analysis, you can specify for each member or set of members whether flexural 
buckling occurs in y- and/or z-direction. Furthermore, you can define additional lateral supports 
in order to represent the model close to reality. STEEL NTC-DF determines the slenderness and 
elastic critical buckling loads from the boundary conditions. The ideal critical moment for lat-
eral torsional buckling required for the lateral torsional buckling design can be determined au-
tomatically. In addition to that, it is possible to take into account the load application point of 
transverse loads, which is affecting the torsional resistance considerably. 

For models with extremely slender cross-sections, the serviceability limit state represents an 
important design. The limit deformations are preset by default settings and can be adjusted, if 
necessary. In addition, it is possible to specify reference lengths and precambers that are con-
sidered accordingly in the design. 

If required, you can optimize cross-sections and export the modified cross-sections to RSTAB. 
The design cases enable you to design separate structural components in complex structures 
or analyze variants. 

STEEL NTC-DF is an add-on module integrated in RSTAB. For this reason, the design relevant 
input data is already preset when you have started the module. Subsequent to the design, you 
can use the graphical RSTAB user interface to evaluate the results. Finally, the design process 
can be documented in the global printout report from the determination of internal forces to 
the design. 

We hope you will enjoy working with STEEL NTC-DF. 

Your DLUBAL Team  
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1.3 Using the Manual 
Topics like installation, graphical user interface, results evaluation, and printout are described 
in detail in the manual of the main program RSTAB. The present manual focuses on typical fea-
tures of the add-on module STEEL NTC-DF. 

The descriptions in this manual follow the sequence and structure of the module's input and 
results windows. In the text, the described buttons are given in square brackets, for example 
[View mode]. At the same time, they are pictured on the left. Expressions appearing in dialog 
boxes, windows, and menus are set in italics to clarify the explanations. 

At the end of the manual, you find the index. However, if you still cannot find what you are 
looking for, please check our website www.dlubal.com where you can go through our FAQ 
pages by selecting particular criteria. 

1.4 Open the Add-on Module STEEL NTC-DF 
RSTAB provides the following options to start the add-on module STEEL NTC-DF. 

Menu 
To start the program in the RSTAB menu bar, click 

Add-on Modules → Design - Steel → STEEL NTC-DF. 

 

Figure 1.1: Menu: Add-on Modules → Design - Steel → STEEL  NTC-DF 

http://www.dlubal.com/
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Navigator 
As an alternative, you can start the add-on module in the Data navigator by clicking 

Add-on Modules → STEEL NTC-DF. 

 

Figure 1.2: Data navigator: Add-on Modules → STEEL  NTC-DF 

Panel 
If results from STEEL NTC-DF are already available in the RSTAB model, you can also open the 
design module in the panel: 

Set the relevant STEEL NTC-DF design case in the load case list of the RSTAB toolbar. Then click 
the [Show Results] button to display the design criterion on the members graphically. 

When the results display is activated, the panel is available, too. Click [STEEL NTC-DF] in the 
panel to open the module. 

 
Figure 1.3: Panel button [STEEL NTC-DF] 
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2.  Input Data 
When you have started the add-on module, a new window opens. In this window, a Navigator 
is displayed on the left, managing the windows that can be currently selected. The drop-down 
list above the navigator contains the design cases (see chapter 7.1, page 51). 

The design relevant data is defined in several input windows. When you open STEEL NTC-DF 
for the first time, the following parameters are imported automatically: 

• Members and sets of members 

• Load cases, load combinations, result combinations, and super combinations 

• Materials 

• Cross-sections 

• Effective lengths 

• Internal forces (in background, if calculated) 

To select a window, click the corresponding entry in the navigator. To set the previous or next 
input window, use the buttons shown on the left. You can also use the function keys to select 
the next [F2] or previous [F3] window. 

Click [OK] to save the results. Thus, you exit STEEL NTC-DF and return to the main program. To 
exit the module without saving the data, click [Cancel]. 

2.1 General Data 
In the 1.1 General Data window, you select the members, sets of members, and actions that 
you want to design. The tabs are managing the load cases, load combinations, result combina-
tions, and super combinations for the different designs. 

 
Figure 2.1: Window 1.1 General Data 
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Design of 

 
Figure 2.2: Design of members and sets of members 

The design can be carried out for Members as well as for Sets of Members. If you want to design 
only selected objects, clear the All check box: Then you can access the input fields to enter the 
numbers of the relevant members or sets of members. The list of the numbers preset in the 
field can be selected by double-clicking and overwritten by entering the data manually. Alter-
natively, you can select the objects graphically in the RSTAB work window after clicking []. 

When you design a set of members, the program determines the extreme values of the anal-
yses of all members contained in the set of members and takes into account the boundary 
conditions of connected members for the stability analysis. The results are shown in the results 
windows 2.3 Design by Set of Members, 3.2 Governing Internal Forces by Set of Members, and  
4.2 Parts List by Set of Members. 

Click [New] to create a new set of members. The dialog box that you already know from RSTAB 
appears where you can specify the parameters for a set of members. 

2.1.1 Ultimate Limit State 

 
Figure 2.3: Window 1.1 General Data, tab Ultimate Limit State 

Existing Load Cases and Combinations 
In this column, all load cases, load combinations, result combinations, and super combinations 
created in RSTAB are listed.  

Click [] to transfer selected entries to the list Selected for Design on the right side. You can also 
double-click the items. To transfer the complete list to the right, click []. 

To transfer multiple entries of load cases, select them while pressing the [Ctrl] key, as common 
for Windows applications. Then use the button [] to transfer them simultaneously. 

Load cases marked by an asterisk (*), like load case 8 in Figure 2.3, cannot be designed: This 
happens when the load cases are defined without any load data or the load cases contain only 
imperfections. When you transfer the load cases, a corresponding warning appears. 
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At the end of the list, several filter options are available. They will help you assign the entries 
sorted by load case, load combination, or action category. The buttons have the following 
functions: 

 
Selects all cases in the list 

 
Inverts selection of load cases 

Table 2.1: Buttons in the tab Ultimate Limit State 

Selected for Design 
The column on the right lists the load cases as well as the load and result combinations select-
ed for design. To remove selected items from the list, click [] or double-click the entries. To 
transfer the entire list to the left, click []. 

The analysis of an enveloping max/min result combination is performed faster than the analy-
sis of all load cases and load combinations that have been globally set. However, when analyz-
ing a result combination, the influence of the contained loads is difficult to discern. 

2.1.2 Serviceability 

 
Figure 2.4: Window 1.1 General Data, tab Serviceability Limit State 

Existing Load Cases and Combinations 
This section lists all load cases, load combinations, and result combinations created in RSTAB. 

Selected for Design 
Load cases, load combinations, and result combinations can be added or removed, as de-
scribed in chapter 2.1.1. 

You can assign different limit values for deflection to the individual load cases, load combina-
tions, and result combinations. Those limit values of the deformations can be adjusted, if nec-
essary: Click [Details] to open the dialog box Details (see Figure 3.3, page 30). 

In the 1.9 Serviceability Data window, the reference lengths that are governing for the defor-
mation check are managed (see chapter 2.9, page 25). 
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2.2 Materials 
The window is subdivided into two parts. In the upper part, all materials created in RSTAB are 
listed. The Material Properties section shows the properties of the current material, that is, the 
table row currently selected in the upper section. 

 
Figure 2.5: Window 1.2 Materials 

Materials that will not be used in the design are dimmed. Materials that are not allowed are 
highlighted in red. Modified materials are displayed in blue. 

The material properties required for the determination of internal forces are described in chap-
ter 4.2 of the RSTAB manual (Main Properties). The material properties required for design are 
stored in the global material library. The values are preset (Additional Properties). 

To adjust the units and decimal places of material properties and stresses, select from the 
module's menu Settings → Units and Decimal Places (see chapter 7.3, page 55). 

Material Description 
The materials defined in RSTAB are already preset, but you can always modify them: To select 
the field, click the material in column A. Then click [] or press function key [F7] to open the 
material list. 

 
Figure 2.6: List of materials 

According to the design concept of the standard [1], you can select only materials of the 
“Steel” category. 
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When you have imported a material, the design relevant Material Properties are updated. 

If you change the material description manually and the entry is stored in the material library, 
STEEL NTC-DF will import the material properties, too. 

Principally, it is not possible to edit the material properties in the add-on module STEEL NTC-DF. 

Material Library 
Numerous materials are already available in the library. To open the corresponding dialog box, 
click 

Edit → Material Library 

or use the button shown on the left. 

 
Figure 2.7: Dialog box Material Library 

In the Filter section, Steel is preset as material category. Select the material quality that you 
want to use for the design in the Material to Select list. The corresponding properties can be 
checked in the dialog section below. 

Click [OK] or [↵] to transfer the selected material to window 1.2 of the module STEEL NTC-DF. 

Chapter 4.2 in the RSTAB manual describes in detail how materials can be filtered, added, or 
rearranged. 

You can also select material categories like Cast Iron or Stainless Steel. Please check, however, 
whether these materials are allowed by the design concept of the standard [1]. 
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2.3 Cross-sections 
This window manages the cross-sections used for design. In addition, the module window 
allows you to specify optimization parameters. 

 
Figure 2.8: Window 1.3 Cross-sections 

Cross-Section Description 
The cross-sections defined in RSTAB are preset together with the assigned material numbers. 

To modify a cross-section, click the entry in column B selecting this field. Click [Cross-section 
Library] or [...] in the field or press function key [F7] to open the cross-section table of the cur-
rent input field (see the following figure). 

In this dialog box, you can select a different cross-section or a different cross-section table. To 
select a different cross-section category, click [Back to cross-section library] to access the gen-
eral cross-section library. 

Chapter 4.3 of the RSTAB manual describes how cross-sections can be selected from the library. 



2  Input Data 

 

 

 

14 Program STEEL NTC-DF © 2013 Dlubal Software GmbH 

 

 
Figure 2.9: IS cross-sections in the cross-section library 

The new cross-section description can be entered in the input field directly. If the data base 
contains an entry, STEEL NTC-DF imports these cross-section parameters, too. 

A modified cross-section will be highlighted in blue. 

If cross-sections set in STEEL NTC-DF are different from the ones used in RSTAB, both cross-
sections are displayed in the graphic on the right. The designs will be performed with the in-
ternal forces from RSTAB for the cross-section selected in STEEL NTC-DF. 

Cross-Section Type for Classification 
The cross-section type used for the classification is displayed. The cross-sections listed in [1] 
Table 5.2 can be designed plastically or elastically depending on the Class. Cross-sections that 
are not covered by this table are classified as General. 

Max. Design Ratio 
This table column is displayed only after the calculation. It is a decision support for the optimi-
zation. By means of the displayed design ratio and colored relation scales, you can see which 
cross-sections are little utilized and thus oversized, or overloaded and thus undersized. 

Optimize 
You can optimize every cross-section from the library: For the RSTAB internal forces, the pro-
gram searches the cross-section that comes as close as possible to a user-defined maximum 
utilization ratio. You can define the maximum ratio in the Other tab of the Details dialog box, 
(see Figure 3.4, page 31). 

To optimize a cross-section, open the drop-down list in column D or E and select the desired 
entry: From Current Row or, if available, From favorites 'Description'. Recommendations for the 
cross-section optimization can be found in chapter 7.2 on page 53. 
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Remark 
This column shows remarks in the form of footers that are described in detail below the cross-
section list. 

A warning might appear before the calculation: Incorrect type of cross-section! This means that 
there is a cross-section that is not stored in the data base. This may be a user-defined cross-
section or a SHAPE-THIN cross-section that has not been calculated yet. To select an appropri-
ate cross-section for design, click [Library] (see description in Figure 2.8). 

Member with tapered cross-section 
For tapered members with different cross-sections at the member start and member end, the 
module displays both cross-section numbers in two tables, in accordance with the definition in 
RSTAB. 

STEEL NTC-DF also designs tapered members, provided that the cross-section at the member's 
start has the same number of stress points as the cross-section at the member end. For exam-
ple, the normal stresses, are determined from the moments of inertia and the centroidal dis-
tances of the stress points. If the cross-sections at the start and the end of a tapered member 
have a different number of stress points, the intermediate values cannot be interpolated. The 
calculation is possible neither in RSTAB nor in STEEL NTC-DF. 

The cross-section's stress points including numbering can also be checked graphically: Select 
the cross-section in window 1.3 and click [Info]. The dialog box shown in Figure 2.10 appears. 

Info About Cross-Section 
In the dialog box Info About Cross-Section, you can view the cross-section properties, stress 
points, and c/t-parts. 

 
Figure 2.10: Dialog box Info About Cross-Section 

In the right part of the dialog box, the currently selected cross-section is displayed. 
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The buttons below the graphic are reserved for the following functions: 

 

 

Table 2.2: Buttons of cross-section graphic 

Click [Details] to call up detailed information on stress points (distance to center of gravity, 
statical moments of area, normalized warping constants etc.) and c/t-parts. 

 
Figure 2.11: Dialog box Stress Points of HE B 260 

Button Function 

 
Displays or hides the stress points 

 
Displays or hides the c/t-parts 

 
Displays or hides the numbering of stress points or c/t-parts 

 
Displays or hides the details of the stress points or c/t-parts (see Figure 2.11) 

 
Displays or hides the dimensions of the cross-section 

 
Displays or hides the principal axes of the cross-section 

 
Resets the full view of the cross-section graphic 
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2.4 Intermediate Lateral Restraints 
In window 1.4, you can define intermediate lateral restraints for members. STEEL NTC-DF 
always assumes this kind of support to be perpendicular to the cross-section's minor axis z  
(see Figure 2.10). Thus, it is possible to influence the members' effective lengths which are 
important for the stability analyses concerning flexural buckling and lateral-torsional buckling. 

For the calculation, intermediate lateral restraints are considered as torsional supports. 

 
Figure 2.12: Window 1.4 Intermediate Lateral Restraints 

In the upper part of the window, you can assign up to nine lateral restraints for each member. 
The Settings section shows the input as column overview for the member selected above. 

To define the intermediate restraints of a member, select the Lateral Restraint check box in  
column A. To graphically select the member and to activate its row, click []. By selecting the 
check box, the other columns become available for you to enter the parameters. 

In column C, you specify the number of the intermediate restraints. Depending on the specifi-
cation, one or more of the following Intermediate Lateral Restraints columns for the definition 
of the x-locations are available. 

If the check box Relatively (0 … 1) is selected, the support points can be defined by relative in-
put. The positions of the intermediate restraints are determined from the member length and 
the relative distances from the member start. If the Relatively (0 ... 1) check box is cleared, you 
can define the distances manually in the upper table. 

In case of cantilevers, avoid intermediate restraints because such supports divide the member 
into segments. For cantilevered beams, this would result in segments with lateral torsional re-
straints on one end each that are statically underdetermined. 
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2.5 Effective Lengths - Members 
The window is subdivided into two parts. The table in the upper part contains summarized in-
formation about the factors for the lengths of buckling and lateral-torsional buckling as well as 
the equivalent member lengths of the members to be designed. The effective lengths defined 
in RSTAB are preset. In the Settings section, you can see further information on the member 
whose row is selected in the upper section. 

Click the button [] to select a member graphically and to show its row. 

Changes can be made in the table as well as in the Settings tree. 

 
Figure 2.13: Window 1.5 Effective Lengths - Members 

The effective lengths for buckling about the minor z-axis are aligned automatically with the 
entries of the 1.4 Intermediate Lateral Restraints window. If intermediate restraints divide the 
member into member segments of different lengths, the program displays no values in the 
table columns G, I, and J of window 1.5. 

The effective lengths can be entered manually in the table and in the Settings tree, or defined 
graphically in the work window after clicking [...]. This button is enabled when you click in the 
input field (see figure above). 

The Settings tree manages the following parameters: 

• Cross-Section 

• Member Length 

• Buckling Possible for member (cf columns B and E) 

• Buckling about Axis y Possible (cf columns C and D) 

• Buckling about Axis z Possible (cf columns F and G) 

• Lateral-Torsional Buckling Possible (cf columns I - K) 

In this table, you can specify for the currently selected member whether to carry out a buckling 
or a lateral-torsional buckling analysis. In addition to this, you can adjust the Effective Length 
Factor for the respective lengths. When a coefficient is modified, the equivalent member 
length is adjusted automatically, and vice versa. 
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Axis system 

You can also define the buckling length of a member in a dialog box. To open it, click the 
button shown on the left. It is located on the right below the upper table of the window. 

 
Figure 2.14: Dialog box Select Effective Length Factor 

For each direction, the buckling length can be defined according to one of the Euler buckling 
modes or User-defined. If a RSBUCK case calculated according to the eigenvalue analysis is al-
ready available, you can also define a Buckling Shape to determine the factor. 

Buckling Possible 
A stability analysis for flexural buckling requires the ability of members to absorb compressive 
forces. Therefore, members for which such absorption is not possible because of the member 
type (for example tension members, elastic foundations, rigid connections) are excluded from 
design in the first place. The corresponding rows appear dimmed and a note is displayed in 
the Comment column. 

The Buckling Possible check boxes in table row A and in the Settings tree offer you a control op-
tion for the stability analyses: They determine whether the analysis should or should not be 
performed for a member. 

Buckling about Axis y or Axis z 
With the check boxes in the Possible table columns, you decide whether a member is suscepti-
ble to buckling about the y-axis and/or z-axis. These axes represent the local member axes, 
with axis y being the major and axis z the minor member axis. The buckling length coefficients 
Ky and K,z for buckling about the major or the minor axis can be selected freely. 

You can check the position of the member axes in the cross-section graphic in the 1.3 Cross-
Sections window (see Figure 2.8, page 13). To access the RSTAB work window, click [View 
mode]. In the work window, you can display the local member axes by using the member's 
context menu or the Display navigator (see figure below). 
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Figure 2.15: Selecting the member axis systems in the Display navigator of RSTAB 

If buckling is possible about one or even both member axes, you can enter the effective length 
factors as well as the buckling lengths in the columns C and D or F and G. The same is possible 
in the Settings tree. 

To specify the buckling lengths in the work window graphically, click [...]. This button becomes 
available when you click in a KL-input field (see Figure 2.13). 

When you specify the effective length factor K, the program determines the effective length KL 
by multiplying the member length L by the effective length factor K. The input fields K and KL 
are interactive.  

Lateral-Torsional and Torsional-Flexural Buckling Possible 
Table column H shows you for which members the program performs an analysis of lateral-
torsional and torsional-flexural buckling. 

With the check box in the Possible columns, you decide whether a member is susceptible to 
torsional buckling. The LTB lengths Lw and the torsional lengths LT in columns I and J can be 
edited by the user. 

Elastic Buckling Moment Mu 

The list in column K includes four options for the calculation of the nominal bending resistance 
moment Mu. It can be accessed by clicking the button [] which appears after clicking in a cell 
of this table column. 

• Eq. (3.24) 

Mu is calculated according to [1] clause 3.3.2.2. 
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• Use factor Cb 

The modification factor Cb is calculated according to the AISC standard [2] equation F1-1. 

 
M3M4M3M5.2

 M12.5
C

CBAmax

max
b +++
=  

  where 

Mmax absolute value of maximum bending moment in unbraced segment 

MA  absolute value of bending moment at quarter point of segment 

MB absolute value of bending moment at center of member or segment 

MC  absolute value of bending moment at three-quarter point of segment 
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The nominal bending resistance moment is then calculated with this modification factor. 
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• Eigenvalue 

This option is set as default. It uses the general eigenvalue solver to determinate the 
elastic buckling moment. 

• Manually 

The value of Mu can be defined individually. 

Comment 
In the last table column, you can enter your own comments for each member to describe, for 
example, the selected effective member lengths. 

2.6 Effective Lengths - Sets of Members 
This window appears only if you have selected at least one set of members for design in the 
1.1 General Data window (see Figure 3.2, page 28). 

 
Figure 2.16: Window 1.6 Effective Lengths - Sets of Members 

The concept of this window is similar to the one in the previous 1.5 Effective Lengths - Members 
window. In this window, you can enter the effective lengths for the buckling about the two 
principal axes of the set of members as described in chapter 2.5. 
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2.7 Nodal Supports - Sets of Members 
This window is displayed only if you have selected at least one set of members for the design 
in the 1.1 General Data window. 

If the Member-Like Input is selected for sets of members in the dialog box Details dialog box, 
tab Stability (see Figure 3.2, page 28), window 1.7 will not be displayed. In that case, you can 
define the intermediate lateral restraints by using division points in window 1.4. 

 
Figure 2.17: Window 1.7 Nodal Supports - Set of Members 

To determine critical buckling factor of lateral-torsional buckling, a planar framework is creat-
ed with four degrees of freedom for each node, which you have to define in window 1.7. This 
window refers to the current set of members (selected in the add-on module's navigator on 
the left). 

The orientation of the axes in the set of members is important for the definition of nodal sup-
ports. The program checks the position of the nodes and internally defines, according to Fig-
ure 2.18 to Figure 2.21, the axes of the nodal supports for window 1.7. 

 
Figure 2.18: Auxiliary coordinate system for nodal supports – straight set of members 

If all members of a set of members lie in a straight line as shown in Figure 2.18, the local coor-
dinate system of the first member in the set of members corresponds to the equivalent coor-
dinate system of the entire set of members. 
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Figure 2.19: Auxiliary coordinate system for nodal supports – set of members in vertical plane 

If members of a set of members are not lying in a straight line, they must at least lie in the same 
plane. In Figure 2.19, they are lying in a vertical plane. In this case, the axis X' is horizontal and 
aligned in direction of the plane. The axis Y' is horizontal as well and defined perpendicular to 
the axis X'. The axis Z' is directed perpendicularly downwards. 

 
Figure 2.20: Auxiliary coordinate system for nodal supports – set of members in horizontal plane 

If the members of a buckled set of members are lying in a horizontal plane, the X'-axis is de-
fined parallel to the X-axis of the global coordinate system. Thus, the Y'-axis is oriented in the 
opposite direction to the global Z-axis and the axis Z' is directed parallel to the global Y-axis. 

 
Figure 2.21: Auxiliary coordinate system for nodal supports – set of members in inclined plane 

Figure 2.21 shows the general case of a buckled set of members: The members are not lying in 
one straight line but in an inclined plane. The definition of the X'-axis arises out of the intersec-
tion line of the inclined plane with the horizontal plane. Thus, the Y'-axis is defined perpendic-
ular to the axis X' and directed perpendicular to the inclined plane. The Z'-axis is defined per-
pendicular to the X'- and Y'-axes. 
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2.8 Member End Releases - Sets of Members 
This window is displayed only if you have selected at least one set of members for the design 
in the 1.1 General Data window. Here, you can define releases for members and sets of mem-
bers that, due to structural reasons, do not transfer the locked degrees of freedom specified in 
window 1.7 as internal forces. This window refers to the current set of members (selected in 
the add-on module's navigator on the left). 

Window 1.8 will not be displayed when in the Details dialog box (see Figure 3.2, page 28) the 
Member-Like Input is selected for sets of members. 

 
Figure 2.22: Window 1.8 Member Releases - Set of Members 

In table column B, you define the Member Side to which the release should be assigned. You 
can also connect the releases to both member sides. 

In the columns C through F, you can define releases or spring constants to align the set of 
members model with the support conditions in window 1.7. 
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2.9 Serviceability Data 

This input window controls several settings for the serviceability limit state design. It is only 
available if you have set the according entries in the Serviceability Limit State tab of window 1.1 
(see chapter 2.1.2, page 10). 

 
Figure 2.23: Window 1.9 Serviceability Data 

In column A, you decide whether you want to apply the deformation to single members, lists 
of members, or sets of members. 

In table column B, you enter the numbers of the members or sets of members that you want to 
design. You can also click [...] to select them graphically in the RSTAB work window. Then, the 
Reference Length appears in column D automatically. This column presets the lengths of the 
members, sets of members, or member lists. If required, you can adjust these values after se-
lecting the Manually check box in column C. 

In table column E, you define the governing Direction for the deformation analysis. You can  
select the directions of the local member axes y and z (or u and v for unsymmetrical cross-
sections). 

In column F, you can consider a precamber wc. 

The Beam Type is of vital importance for the correct application of limit deformations. In col-
umn G, you can specify whether there is a beam or a cantilever and which end should have no 
support. 

The settings in the Serviceability tab of the Details dialog box decide whether the deformations 
are related to the undeformed initial model or to the shifted ends of members or sets of mem-
bers (see Figure 3.3, page 30). 
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2.10 Parameters - Members 

The last input window controls additional design parameters for members. 

If the Cross-Sectional Area of a member is to be considered by specific parameters, set a check 
in relevant line of column A. You can then define the Cross-sectional areas for tension design in 
the Settings table below (net and effective areas, shear lag factor U). 

 
Figure 2.24: Window 1.10 Parameters - Members 

Those parameters are relevant for the design of member connections and of cross-sections 
with tension. 
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3.  Calculation 
 

3.1 Detail Settings 
Before you start the [Calculation], it is recommended to check the design details. You can open 
the corresponding dialog box in all windows of the add-on module by clicking [Details]. 

The dialog box Details contains the following tabs: 

• Ultimate Limit State 

• Stability 

• Serviceability 

• Other 

3.1.1 Ultimate Limit State 

 
Figure 3.1: Dialog box Details, tab Ultimate Limit State 

Options 
According to [1] clause 1.5, there is also a Plastic design possible for members. If the require-
ments given in clause 1.5(a) are satisfied, hot-formed doubly symmetric I-sections can be de-
signed according to this option. Cross-sections that are assigned to type 1 or 2 (“compact”) will 
be designed plastically in STEEL NTC-DF. If you do not want to perform a plastic design, you 
can activate the Elastic design for these cross-sections, too. Then all cross-sections will be con-
sidered as type 3 (“non-compact”). 
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Alternatively, a conservative general elastic design based on stress analysis in stress points and 
VON MISES equivalent stresses can be applied. This option is useful for cross-sections with com-
plex shapes or for members with torsional moments etc. 

If the Shear design of solid flat or round bars or Shear buckling design of webs is not required in 
special cases, this design option can be deactivated. 

The conservative General elastic design of shear based on the shear stress analysis in stress 
points can be activated additionally. 

Limit Internal Forces for Interaction 
The standard [1] offers no exact procedure how to design cross-sections under the torsion. 
Therefore, there is an option to ignore shear stress due to torsion for the cross-section design. 
You can enter the maximum ratio of torsional shear stress and shear strength so that the de-
sign is possible in spite of small torsional moments. 

Seismic Design 
The factor of seismic behavior Q can be edited, if necessary. This value is used to determine the 
cross-section type according to [1] Table 2.1. 

3.1.2 Stability 

 
Figure 3.2: Dialog box Details, tab Stability 

Stability Analysis 
The Use check box controls whether to run, in addition to the cross-section checks, a stability 
analysis. If you clear the check box, the input windows 1.4 through 1.8 will not be displayed. 
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Second Order Effects 
If a load case is calculated according to a linear static analysis, you can consider the effects from 
2nd order theory by increasing the bending moment about the major and/or minor axis, according 
to [1] clauses 1.5.1.1 and 3.4.3.3(b). When you design, for example, a frame whose governing 
buckling mode is represented by lateral displacement, you can determine the internal forces 
according to linear static analysis and increase them by the appropriate factors. If you increase 
the bending moment, it does not affect the flexural-buckling analysis according to [1] as it is 
performed by using the axial forces. 

The Determination of factor C can be by default C = 1.00 or according to clause 1.5.1.1(a) and (b). 
The bending moments Mti and Mtp are determined in very simple way – as constant ratio to the 
total bending moment value. This ratio is constant for all members. If second order effects are 
included, the factors B1 and B2 are used to calculate the final design values Muo and M*uo ac-
cording to [1] Eq. (1.1) and (1.2) for plastic design and also according to Eq. (3.59) to (3.62). The 
Stability factor I of the entire frame (model) according to clause 2.2.2 can be edited, if necessary. 

Lateral-Torsional Buckling 
If transverse loads are present, it is important to define where these forces are acting on the 
cross-section: Depending on the Load application point, transverse loads can be stabilizing or 
destabilizing, and thus can decisively influence the ideal critical moment. The determination of 
the buckling factor αcr for set of members is based on those settings. Please note that the load 
application point is only taken into account for sets of members. 

Determination of Bending Design Resistance Mm 
The value of the bending design resistance Mm is required for cross-section types 1 or 2 accord-
ing to [1] clause 3.4.3.2, Eq. (3.56). This value can be calculated according to clause 3.3.2 or, ap-
proximately, according to Eq. (3.57) for I-sections. When this option is checked, Mm is deter-
mined, the approximate calculation is applied according to the Eq. (3.57) for I-sections, and ac-
cording to clause 3.3.2 for all other cross-sections. 

Set of Members - Member-Like Input 
It is recommended to apply the STEEL NTC-DF design only for straight sets of members. The 
stability data can be defined as member-like in window 1.6 (to treat a set of member like one 
single member) or as general in windows 1.7 and 1.8 (default). If the latter option Do not use 
member-like input is set, the support conditions have to be defined in window 1.7 for the sets 
of members.  

With the option Use for all sets of members, you can define all stability data for sets of members 
in window 1.6 analogically to window 1.5 for single members. In this case, windows 1.7 and 1.8 
are not displayed. The default simple girder values are used to determine the support condi-
tions β, uy, φx, φz and ω. 

It is possible to use the member-like input only for straight sets of members with equal cross-
section parameters. Windows 1.7 and 1.8 won’t be displayed for straight sets. This option can 
be used e.g. for continuous beams. 

The fourth option applies the member-like input only to straight sets of members without inter-
mediate restraints modeled in RSTAB. Thus, only sets of members which have RSTAB supports/ 
restraints at their ends will be considered for the member-like input. This option can be used 
to design e.g. simple beams or cantilevers. The connection of transverse beams to the inter-
mediate nodes of the set is not accounted for, however. Windows 1.7 and 1.8 won’t be dis-
played for straight sets that have no intermediate restraints. 

Welded I- and H-Section Fabrication 
For I- and H-sections, Rolled or Flame-cut fabrication methods are possible. The member section 
constant n as specified in [1] clause 3.2.2.1(a) depends on this type of fabrication. The selected 
type is then applied to all I and H sections of the design case. 
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Limit Load for Special Cases 
To design cross-sections for intended axial compression according to [1] clause 3.2, it is possi-
ble to neglect small moments about the major and the minor axes by settings defined in this 
dialog section. 

In the same way, you can switch off small compression forces for the pure design of bending by 
defining a limit ratio for Pu to FR Rp. 

Intended torsion is not clearly specified in [1]. If a torsional stress is available that is not exceed-
ing the shear stress ratio of 1 % preset by default, it is not considered in the stability design. In 
this case, the output shows results for flexural buckling and lateral-torsional buckling. 

If one of the limits in this dialog section is exceeded, a note appears in the results window. No 
stability analysis is carried out. Nevertheless, the cross-section checks are run independently. 
These limit settings are not part of the Mexican standard. Changing the limits is in the respon-
sibility of the program user. 

3.1.3 Serviceability 

 
Figure 3.3: Dialog box Details, tab Serviceability 

Deformation Relative to 
The option fields control whether the maximum deformations are related to the shifted ends 
of members or sets of members (connection line between start and end nodes of the de-
formed system) or to the undeformed initial system. As a rule, the deformations have to be 
checked relative to the displacements in the entire structural system. 

Serviceability Limits (Deflections) 
Here you can check and, if necessary, adjust the limit deformations of beams and cantilevers. 
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3.1.4 Other 

 
Figure 3.4: Dialog box Details, tab Other 

Cross-Section Optimization 
The optimization is targeted on the maximum stress ratio of 100 %. If necessary, you can speci-
fy a different limit value in this input field. 

Check of Member Slendernesses 
In the two input fields, you can specify the limit values λlimit (the ratios K · L / r) in order to define 
member slendernesses. It is possible to enter specifications separately for members with pure 
tension forces and members with bending and compression. The default values are given in 
[1] clause 2.2.3. 

The limit values are compared to the real member slendernesses in window 3.3. This window  
is available after the calculation (see chapter 4.8, page 40 ) if the corresponding check box is 
selected in the Display Result Tables dialog box section. 

Display Result Tables 
In this dialog section, you can select the results windows including parts list that you want to 
be displayed. Those windows are described in chapter 4 Results. 

The 3.3 Member Slendernesses window is inactive by default. 
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3.2 Start Calculation 
To start the calculation, click the [Calculation] button that is available in all input windows of 
the STEEL NTC-DF add-on module. 

STEEL NTC-DF searches for the results of the load cases, load combinations, and result combi-
nations to be designed. If these cannot be found, the program starts the RSTAB calculation to 
determine the design relevant internal forces. 

You can also start the calculation in the RSTAB user interface: The dialog box To Calculate 
(menu Calculate → To Calculate) lists design cases of the add-on modules like load cases and 
load combinations are listed. 

 
Figure 3.5: Dialog box To Calculate 

If the STEEL NTC-DF cases are missing in the Not Calculated section, select All or Add-on Modules 
in the drop-down list at the end of the list. 

To transfer the selected STEEL NTC-DF cases to the list on the right, use the button []. Click [OK] 
to start the calculation. 

To calculate a design case directly, use the list in the toolbar. Select the STEEL NTC-DF case in 
the toolbar list, and then click [Show Results]. 

 
Figure 3.6: Direct calculation of a STEEL NTC-DF design case in RSTAB 

Subsequently, you can observe the design process in a separate dialog box. 
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4.  Results 
Window 2.1 Design by Load Case is displayed immediately after the calculation. 

 
Figure 4.1: Results window with designs and intermediate values 

The designs are shown in the results windows 2.1 through 2.5, sorted by different criteria. 

The windows 3.1 and 3.2 list the governing internal forces. Window 3.3 informs you about the 
member slendernesses. The last two results windows 4.1 and 4.2 show the parts lists sorted by 
member and set of members. 

Every window can be selected by clicking the corresponding entry in the navigator. To set the 
previous or next input window, use the buttons shown on the left. You can also use the func-
tion keys to select the next [F2] or previous [F3] window. 

Click [OK] to save the results. You exit STEEL NTC-DF and return to the main program. 

Chapter 4 Results describes the different results windows one by one. Evaluating and checking 
results is described in chapter 5 Results Evaluation, page 43. 
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4.1 Design by Load Case 
The upper part of the window provides a summary, sorted by load cases, load combinations, 
and result combinations of the governing designs. Furthermore, the list is divided in ultimate 
limit state, serviceability and stability designs. 

The lower part gives detailed information on the cross-section properties, analyzed internal 
forces, and design parameters for the load case selected above. 

 
Figure 4.2: Window 2.1 Design by Load Case 

Description 
This column shows the descriptions of the load cases, load combinations, and result combina-
tions used for the designs. 

Member No. 
This column shows the number of the member that bears the maximum stress ratio of the 
designed loading. 

Location x 
This column shows the respective x-location where the member's maximum stress ratio occurs. 
For the table output, the program uses the following member locations x: 

• Start and end node 

• Division points according to possibly defined member division (see RSTAB table 1.6) 

• Member division according to specification for member results (RSTAB dialog box  
Calculation Parameters, tab Global Register Parameters) 

• Extreme values of internal forces 

Design 
Columns D and E display the design conditions according to [1]. 

The length of the colored scale represents the respective utilization ratio. 
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Design according to Formula 
This column lists the code's equations by which the designs have been performed. 

4.2 Design by Cross-Section 

 
Figure 4.3: Window 2.2 Design by Cross-Section 

This window lists the maximum ratios of all members and actions selected for design, sorted 
by cross-section. The results are sorted by cross-section design, stability analysis and servicea-
bility limit state design. 

If there is a tapered member, both cross-section descriptions are displayed in the table row 
next to the section number. 
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4.3 Design by Set of Members 

 
Figure 4.4: Window 2.3 Design by Set of Members 

This results window is displayed if you have selected at least one set of members for design. 
The window lists the maximum utilization ratios sorted by set of members. 

The Member No. column shows the number of the one member within the set of members that 
bears the maximum ratio for the individual design criteria. 

The output by set of members clearly presents the design for an entire structural group (for 
example a frame). 
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4.4 Design by Member 

 
Figure 4.5: Window 2.4 Design by Member 

This results window presents the maximum utilization ratios for the individual designs sorted 
by member number. The columns are described in detail in chapter 4.1 on page 34. 

4.5 Design by x-Location 

 
Figure 4.6: Window 2.5 Design by x-Location 
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This results window lists the maxima for each member at the locations x resulting from the 
division points in RSTAB: 

• Start and end node 

• Division points according to possibly defined member division (see RSTAB table 1.6) 

• Member division according to specification for member results (RSTAB dialog box  
Calculation Parameters, tab Global Register Parameters)  

• Extreme values of internal forces 

4.6 Governing Internal Forces by Member 

 
Figure 4.7: Window 3.1 Governing Internal Forces by Member 

For each member, this window displays the governing internal forces, that is, those internal 
forces that result in the maximum utilization in each design. 

Location x 
At this x location of the member, the respective maximum design ratio occurs. 

Loading 
This column displays the number of the load case, the load combination, or result combination 
whose internal forces result in the maximum design ratios. 

Forces / Moments 
For each member, this column displays the axial and shear forces as well as the torsional and 
bending moments producing maximum ratios in the respective cross-section designs, stability 
analyses, and serviceability limit state designs. 

Design According to Formula 
The final column informs you about the design types and the equations by which the designs 
according to [1] have been performed. 
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4.7 Governing Internal Forces by Set of Members 

 
Figure 4.8: Window 3.2 Governing Internal Forces by Set of Members 

This window shows the internal forces that result in the maximum ratios of the design for each 
set of members. 
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4.8 Member Slendernesses 

 
Figure 4.9: Window 3.3 Member Slendernesses 

This results window appears only if you select the respective check box in the Other tab of the 
Details dialog box (see Figure 3.4, page 31). 

The table lists the effective slendernesses of the designed members for both directions of the 
principal axes. They were determined depending on the type of load. At the end of the list, you 
find a comparison with the limit values that have been defined in the Details dialog box, tab 
Other (see Figure 3.4, page 31). 

Members of the member type "Tension" or "Cable" are not included in this window. 

This window is displayed only for information. No stability design of slendernesses is intended. 
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4.9 Parts List by Member 
Finally, STEEL NTC-DF provides a summary of all cross-sections included in the design case. 

 
Figure 4.10: Window 4.1 Parts List by Member 

By default, this list contains only the designed members. If you need a parts list for all members 
of the model, select the corresponding option in the Details dialog box, tab Other (see Figure 
3.4, page 31). 

Part No. 
The program automatically assigns item numbers to similar members. 

Cross-Section Description 
This column lists the cross-section numbers and descriptions. 

Number of Members 
This column shows how many similar members are used for each part. 

Length 
This column displays the respective length of an individual member. 

Total Length 
This column shows the product determined from the two previous columns. 

Surface Area 
For each part, the program indicates the surface area related to the total length. The surface 
area is determined from the Surface Area of the cross-sections that can be seen in windows 1.3 
and 2.1 through 2.5 in the cross-section information (see Figure 2.10, page 15). 
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Volume 
The volume of a part is determined from the cross-sectional area and the total length. 

Unit Weight 
The Unit Weight of the cross-section is relative to the length of one meter. For tapered cross-
sections, the program averages both cross-section masses. 

Weight 
The values of this column are determined from the respective product of the entries in column 
C and G. 

Total Weight 
The final column indicates the total mass of each part. 

Sum 
At the bottom of the list, you find a sum of the values in the columns B, D, E, F, and I. The last 
data field of the column Total Weight gives information about the total amount of steel re-
quired. 

4.10 Parts List by Set of Members  

 
Figure 4.11: Window 4.2 Parts List by Set of Members 

The last results window is displayed if you have selected at least one set of members for de-
sign. The window summarizes an entire structural group (for example a horizontal beam) in a 
parts list. 

Details on the various columns can be found in the previous chapter. If there are different 
cross-sections in a set of members, the program averages the surface area, the volume, and 
the cross-section weight. 
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5.  Results Evaluation 
You can evaluate the design results in different ways. The buttons below the first window part 
can help you to evaluate the results. 

 
Figure 5.1: Buttons for results evaluation 

The buttons have the following functions: 

Button Description Function 

 Ultimate Limit State Designs 
Shows or hides the results of the ultimate limit state 
design 

 
Serviceability Limit State 
Designs 

Shows or hides the results of the serviceability limit 
state design 

 Show Color Bars 
Shows or hides the colored relation scales in the 
results windows 

 Show Rows with Ratio > 1 
Displays only the rows where the ratio is greater  
than 1, and thus the design is failed 

 Result Diagrams 
Opens the window Result Diagram on Member 
 chapter 5.2, page 46 

 Excel Export 
Exports the table to MS Excel / OpenOffice 
 chapter 7.4.3, page 57 

 Member Selection 
Allows you to graphically select a member to  
display its results in the table 

 View Mode 
Jumps to the RSTAB work window to change the 
view 

Table 5.1: Buttons in results windows 2.1 to 2.5 
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5.1 Results in the RSTAB Model 
To evaluate the design results, you can also use the RSTAB work window. 

RSTAB background graphic and view mode 
The RSTAB work window in the background is useful when you want to find the position of a 
particular member in the model: The member selected in the STEEL NTC-DF results window is 
highlighted in the selection color in the background graphic. Furthermore, an arrow indicates 
the member's x-location that is displayed in the selected table row. 

 
Figure 5.2: Indication of the member and the current Location x in the RSTAB model 

If you cannot improve the display by moving the STEEL NTC-DF module window, click [Jump 
to Graphic] to activate the View Mode: The program hides the module window so that you can 
modify the display in the RSTAB user interface. The view mode provides the functions of the 
View menu, for example zooming, moving, or rotating the display. The pointer remains visible. 

Click [Back] to return to the add-on module STEEL NTC-DF. 

RSTAB work window 
You can also graphically check the design ratios in the RSTAB model. Click [Graphics] to exit 
the design module. In the RSTAB work window, the design ratios are now displayed like the  
internal forces of a load case. 

In the Results navigator, you can specify which design ratios of the service and ultimate limit 
state or fire resistance design you want to display graphically. 

To turn the display of design results on or off, use the [Show Results] button known from the 
display of internal forces in RSTAB. To display the result values, click the [Show Values] toolbar 
button to the right. 

The design cases can be set by means of the list in the RSTAB menu bar. 

The RSTAB tables are of no relevance for the evaluation of design results 
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To adjust the graphical representation of the results, you can select Results → Members in the 
Display navigator. The display of the design ratios is Two-Colored by default. 

 

Figure 5.3: Display navigator: Results → Members 

When you select a multicolor representation (options With/Without Diagram or Cross-Sections), 
the color panel becomes available. It provides the common control functions described in de-
tail in the RSTAB manual, chapter 3.4.6. 

 

Figure 5.4: Design ratios with display option Without Diagram 

The graphics of the design results can be transferred to the printout report (see chapter 6.2, 
page 49). 

To return to the STEEL NTC-DF module, click [STEEL NTC-DF] in the panel. 
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5.2 Result Diagrams 
You can also graphically evaluate a member's result distributions in the result diagram. 

To do this, select the member (or set of members) in the STEEL NTC-DF results window by 
clicking in the table row of the member. Then open the Result Diagram on Member dialog box 
by clicking the button shown on the left. The button is located below the upper results table 
(see Figure 5.1, page 43). 

The result diagrams are also available in the RSTAB graphic. To display the diagrams, click 

Results → Result Diagrams for Selected Members 

or use the button in the RSTAB toolbar shown on the left. 

A window opens, graphically showing the distribution of the maximum design values on the 
member or set of members. 

 
Figure 5.5: Dialog box Result Diagram on Member 

Use the list in the toolbar above to choose the relevant STEEL NTC-DF design case. 

The Result Diagram on Member dialog box is described in the RSTAB manual, chapter 9.5. 
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5.3 Filter for Results 
The STEEL NTC-DF results windows allow you to sort the results by various criteria. In addition, 
you can use the filter options described in chapter 9.7 of the RSTAB manual to evaluate the de-
sign results graphically. 

You can use the Visibility option also for STEEL NTC-DF (see RSTAB manual, chapter 9.7.1) to 
filter the members in order to evaluate them. 

Filtering designs 
The design ratios can easily be used as filter criteria in the RSTAB work window which you can 
access by clicking [Graphics]. To apply this filter function, the panel must be displayed. If it is 
not shown, click 

View → Control Panel (Color Scale, Factors, Filter) 

or use the toolbar button shown on the left. 

The panel is described in the RSTAB manual, chapter 3.4.6. The filter settings for the results 
must be defined in the first panel tab (Color spectrum). As this register is not available for the 
two-colored results display, you have to use the Display navigator and set the display options 
Colored With/Without Diagram or Cross-Sections first. 

 
Figure 5.6: Filtering design ratios with adjusted color spectrum 

As the figure above shows, the color spectrum can be set in such a way that only ratios higher 
than 0.50 are shown in a color range between blue and red. 

If you select the Display Hidden Result Diagram option in the Display navigator (Results → Mem-
bers), you can display all design ratio diagrams that are not covered by the color spectrum. 
Those diagrams are represented by dotted lines.  
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Filtering members 
In the Filter tab of the control panel, you can specify the numbers of particular members to 
display their results exclusively, that is, filtered. This function is described in detail in the RSTAB 
manual, chapter 9.7.3. 

 

Figure 5.7: Member filter for the design ratios of a hall frame 

Unlike the partial view function (Visibilities), the graphic displays the entire model. The figure 
above shows the design ratios of a hall frame. The remaining members are displayed in the 
model but are shown without design ratios. 
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6.  Printout 
 

6.1 Printout report 
Similar to RSTAB, the program generates a printout report for the STEEL NTC-DF results, to 
which graphics and descriptions can be added. The selection in the printout report determines 
what data from the design module will be included in the printout. 

The printout report is described in the RSTAB manual. In particular, chapter 10.1.3.5 Selecting 
Data of Add-on Modules describes how to select input and output data from add-on modules 
for the printout report. 

For complex structural systems with many design cases, it is recommended to split the data in-
to several printout reports, thus allowing for a clearly-arranged printout. 

6.2 STEEL NTC-DF Graphic Printout 
In RSTAB, you can add every picture that is displayed in the work window to the printout re-
port or send it directly to a printer. In this way, you can prepare the design ratios displayed on 
the RSTAB model for the printout, too. 

The printing of graphics is described in the RSTAB manual, chapter 10.2. 

Designs on the RSTAB model 
To print the currently displayed graphic of the design ratios, click 

File → Print Graphic 

or use the toolbar button shown on the left. 

 
Figure 6.1: Button Print Graphic in RSTAB toolbar 

Result Diagrams 
You can also transfer the Result Diagram on Member to the report or print it directly by using 
the [Print] button. 

 
Figure 6.2: Button Print Graphic in the dialog box Result Diagram on Member 

The Graphic Printout dialog box appears (see the following page). 
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Figure 6.3: Dialog box Graphic Printout, tab General 

This dialog box is described in the RSTAB manual, chapter 10.2. The RSTAB manual also 
describes the Options and Color Spectrum tab. 

You can move a graphic anywhere within the printout report by using the drag-and-drop 
function. 

To adjust a graphic subsequently in the printout report, right-click the relevant entry in  
the navigator of the printout report. The Properties option in the context menu opens the 
Graphic Printout dialog box, offering various options for adjustment. 

 
Figure 6.4: Dialog box Graphic Printout, tab Options 
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7.  General Functions 
The final chapter describes useful menu functions as well as export options for the designs. 

7.1 Design Cases 
Design cases allow you to group members for the design: In this way, you can combine groups 
of structural components or analyze members with particular design specifications (for exam-
ple changed materials, partial safety factors, optimization). 

It is no problem to analyze the same member or set of members in different design cases. 

To calculate a STEEL NTC-DF design case, you can also use the load case list in the RSTAB toolbar. 

Create New Design Case 
To create a new design case, use the STEEL NTC-DF menu and click 

File → New Case. 

The following dialog box appears: 

 
Figure 7.1: Dialog box New STEEL NTC-DF Case 

In this dialog box, enter a No. (one that is still available) for the new design case. The corre-
sponding Description will make the selection in the load case list easier. 

Click [OK] to open the STEEL NTC-DF window 1.1 General Data where you can enter the design 
data. 

Rename Design Case 
To change the description of a design case, use the STEEL NTC-DF menu and click 

File → Rename Case. 

The following dialog box appears: 

 
Figure 7.2: Dialog box Rename STEEL NTC-DF Case 

In this dialog box, you can define a different Description as well as a different No. for the  
design case. 
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Copy Design Case 
To copy the input data of the current design case, select from the STEEL NTC-DF menu 

File → Copy Case. 

The following dialog box appears: 

 
Figure 7.3: Dialog box Copy STEEL NTC-DF Case 

Define the No. and, if necessary, a Description for the new case. 

Delete Design Case 
To delete design cases, use the STEEL NTC-DF menu and click 

File → Delete Case. 

The following dialog box appears: 

 
Figure 7.4: Dialog box Delete Cases 

The design case can be selected in the list Available Cases. To delete the selected case,  
click [OK]. 
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7.2 Cross-Section Optimization 
The design module offers you the option to optimize overloaded or little utilized cross-sections. 
To do this, select in column D or E of the relevant cross-sections in the 1.3 Cross-Sections win-
dow whether to determine the cross-section From the current row or the user-defined Favorites 
(see Figure 2.8, page 13). You can also start the cross-section optimization in the results win-
dows by using the context menu. 

 
Figure 7.5: Context menu for cross-section optimization 

During the optimization process, the module determines the cross-section that fulfills the anal-
ysis requirements in the most optimal way, that is, comes as close as possible to the maximum 
allowable design ratio specified in the Details dialog box (see Figure 3.4, page 31). The required 
cross-section properties are determined with the internal forces from RSTAB. If another cross-
section proves to be more favorable, this cross-section is used for the design. Then, the graphic 
in window 1.3 shows two cross-sections: the original cross-section from RSTAB and the opti-
mized one (see Figure 7.7). 

For a parameterized cross-section, the following dialog box appears when you select 'Yes' from 
the drop-down list. 

 
Figure 7.6: Dialog box Welded Cross-Sections - I symmetric : Optimize 

By selecting the check boxes in the Optimize column, you decide which parameter(s) you want 
to modify. This enables the Minimum and Maximum columns, where you can specify the upper 
and lower limits of the parameter. The Increment column determines the interval in which the 
size of the parameter varies during the optimization process. 
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If you want to Keep current side proportions, select the corresponding check box. In addition, 
you have to select at least two parameters for optimization. 

Cross-sections based on combined rolled cross-sections cannot be optimized. 

Please note that the internal forces are not automatically recalculated with the changed cross-
sections during the optimization: It is up to you to decide which cross-sections should be 
transferred to RSTAB for recalculation. As a result of optimized cross-sections, internal forces 
may vary significantly because of the changed stiffnesses in the structural system. Therefore, it 
is recommended to recalculate the internal forces of the modified cross-section data after the 
first optimization, and then to optimize the cross-sections once again. 

You can export the modified cross-sections to RSTAB: Go to the 1.3 Cross-Sections window, and 
then click 

Edit → Export All Cross-Sections to RSTAB. 

Alternatively, you can use the context menu in window 1.3 to export optimized cross-sections 
to RSTAB. 

 
Figure 7.7: Context menu in window 1.3 Cross-Sections 

Before the modified cross-sections are transferred to RSTAB, a security query appears as to 
whether the results of RSTAB should be deleted.  

 
Figure 7.8: Query before transfer of modified cross-sections to RSTAB 

By confirming the query and then starting the [Calculation] in the STEEL NTC-DF module, the 
RSTAB internal forces as well as the designs will be determined in one single calculation run. 
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If the modified cross-sections have not been exported to RSTAB yet, you can reimport the orig-
inal cross-sections in the design module by using the options shown in Figure 7.7. Please note 
that this option is only available in window 1.3 Cross-sections. 

If you optimize a tapered member, the program modifies the member start and end. Then it 
linearly interpolates the second moments of area for the intermediate locations. As these mo-
ments are considered with the fourth power, the designs may be inaccurate if the depths of 
the start and end cross-section differ considerably. In such a case, it is recommended to divide 
the taper into several members, thus modeling the taper layout manually. 

7.3 Units and Decimal Places 
Units and decimal places for RSTAB and the add-on modules are managed in one dialog box. 
To define the units in STEEL NTC-DF, use the menu and click 

Settings → Units and Decimal Places. 

The program opens the dialog box that is familiar from RSTAB. STEEL NTC-DF is preset in the 
Program / Module list. 

 
Figure 7.9: Dialog box Units and Decimal Places 

You can save the settings as user profile to reuse them in other models. These functions are 
described in the RSTAB manual, chapter 11.1.3. 
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7.4 Data Transfer 
7.4.1 Export Material  to RSTAB 
If you have adjusted the materials in STEEL NTC-DF for design, you can export the modified 
materials to RSTAB in a similar manner as you can export cross-sections: Open the 1.2 Materials 
window, and then click 

Edit → Export All Materials to RSTAB. 

You can also export the modified materials to RSTAB using the context menu of window 1.2. 

 
Figure 7.10: Context menu of window 1.2 Materials 

Before the modified materials are transferred to RSTAB, a security query appears as to whether 
the results of RSTAB should be deleted. When you have confirmed the query and then start the 
[Calculation] in STEEL NTC-DF, the RSTAB internal forces and designs are determined in one 
single calculation run. 

If the modified materials have not been exported to RSTAB yet, you can transfer the original 
materials to the design module, using the options shown in Figure 7.10. Please note, however, 
that this option is only available in the 1.2 Materials window. 

7.4.2 Export Effective Lengths to RSTAB 
If you have adjusted the materials in STEEL NTC-DF for design, you can export the modified 
materials to RSTAB in a similar manner as you can export cross-sections: Open the window 1.5 
Effective Lengths - Members, and then click 

Edit → Export All Effective Lengths to RSTAB. 

or use the corresponding option on the context menu of window 1.5. 

 
Figure 7.11: Context menu of window 1.5 Effective Lengths - Members 

Before the modified materials are transferred to RSTAB, a security query appears as to whether 
the results of RSTAB should be deleted. 

If the modified effective lengths have not been exported to RSTAB yet, you can reimport the 
original effective lengths to the design module, using the options shown in Figure 7.11. Please 
note, however, that this option is only available in the windows 1.5 Effective Lengths - Members 
and 1.6 Effective Lengths - Sets of Members. 

7.4.3 Export Results 
The STEEL NTC-DF results can also be used by other programs. 

Clipboard 
To copy cells selected in the results windows to the Clipboard, press the keys [Ctrl]+[C]. To in-
sert the cells, for example in a word-processing program, press [Ctrl]+[V]. The headers of the 
table columns will not be transferred. 
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Printout report 
You can print the data of the STEEL NTC-DF add-on module into the global printout report  
(see chapter 6.1, page 49) for export. Then, in the printout report, click 

File → Export to RTF. 

The function is described in the RSTAB manual, chapter 10.1.11. 

Excel / OpenOffice 
STEEL NTC-DF provides a function for the direct data export to MS Excel, OpenOffice.org Calc 
or the file format CSV. To open the corresponding dialog box, click 

File → Export Tables. 

The following export dialog box appears. 

 
Figure 7.12: Dialog box Export - MS Excel 

When you have selected the relevant parameters, you can start the export by clicking [OK].  
Excel or OpenOffice will be started automatically, that is, the programs do not have to be 
opened first. 

 
Figure 7.13: Result in Excel 
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8.  Example 
In our example, we perform the stability analyses of flexural buckling and lateral-torsional 
buckling for a column with double-bending, taking into account the interaction conditions. 

Design values 

System and loads 
q z

2 
m

2 
m

4 
m

Fy

N

z

y

HEB160

 

Figure 8.1: System and design loads (γ times) 

Internal forces according to linear static analysis 

             
  P Muoy Muoz Vy Vz 

Figure 8.2: Internal forces 

Design values of the static loads 

Nd = 300 kN 

qz,d = 5.0 kN/m 

Fy,d = 7.5 kN 
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Design location (decisive x-location) 

The design is performed for all x-locations (see chapter 4.5) of the equivalent member. The 
decisive location is x = 2.00 m. RSTAB determines the following internal forces: 

P = –300.00 kN       Muoy = 10.00 kNm       Muoz = 7.50 kNm      Vy = 3.75 kN      Vz = 0.00 kN 

Cross-Section Properties HE-B 160, Steel B-254 (A36) 

 Property  Symbol Value  Unit 

 Cross-section area  At 5425.00 mm2 

 Moment of inertia  Iy 24920000.00 mm4 

 Moment of inertia  Iz 8892000.00 mm4 

 Governing radius of gyration  ry 67.80 mm 

 Governing radius of gyration  rz 40.50 mm 

 Polar radius of gyration  ro 78.97 mm 

 Polar radius of gyration  ro,M 419.00 mm 

 Cross-section mass  M 42.63 kg/m 

 Torsional constant  J 312400.00 mm4 

 Warping constant  Ca 4.794E+10 mm6 

 Elastic section modulus  Sy 311500.00 mm3 

 Elastic section modulus  Sz 111200.00 mm3 

 Plastic section modulus  Zy 354000.00 mm3 

 Plastic section modulus  Zz 169960.00 mm3 

Flexural buckling about minor axis (⊥ to z-z axis) 
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Cross-section type acc. to [1] Table 2.1 

“2 - compact”:  Ae = At 

Slenderness parameter 
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Constant n acc. to [1] clause 3.2.2.1(1) 

n = 2.00 for hot-rolled I-sections (Fy ≤ 414 MPa, tf ≤ 50 mm) 
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Design resistance in compression 
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Result values from STEEL NTC-DF calculation 

 Compression Axial Force  Pu 300.00 kN   

 Section Resistance  Rs 1220.63 kN   3.2 

 Form Factor  Ae/At 1.000    2.1.3 

 Yield Strength  Fy 250.000 MPa   2.1 

 Modulus of Elasticity  E 200000 MPa   

 Gross Area  At 5425 mm2   

 Second Moment of Area  Iz 8892000 mm4   

 Radius of Gyration  rz 40.486 mm   

 Effective Length  Lz 4000 mm   

 Slenderness  λz 1.112    3.2.2 

 Elastic Flexural Buckling Stress  Fe,z 202.213 MPa   Eq. (3.12) 

 Factor  n 2.000    3.2.2 

 Nominal Critical Stress  Fn,z 157.236 MPa   

 Resistance Factor  FR 0.900    

 Member Resistance  Rc,z 767.71 kN   Eq. (3.3) 

 Design Ratio  η 0.390  < 1  3.2.2 

Flexural buckling about major axis (⊥ to y-y axis) 

Flexural buckling critical stress 
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Flexural buckling critical load 
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Cross-section type acc. to Table 2.1 

“2 - compact”: Ae = At 

Slenderness parameter 
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Constant n acc. to clause 3.2.2.1(1) 

n = 2.00 for hot-rolled I-section (Fy ≤ 414 MPa, tf ≤ 50 mm) 

Design resistance in compression 
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Result values from STEEL NTC-DF calculation 

 Compression Axial Force  Pu 300.00 kN   

 Section Resistance  Rs 1220.63 kN   3.2 

 Form Factor  Ae/At 1.000    2.1.3 

 Yield Strength  Fy 250.000 MPa   2.1 

 Modulus of Elasticity  E 200000 MPa   

 Gross Area  At 5425.000 mm2   

 Second Moment of Area  Iy 24920000 mm4   

 Radius of Gyration  Ry 67.776 mm   

 Effective Length  Ly 4000.000 mm   

 Slenderness  λy 0.664    3.2.2 

 Elastic Flexural Buckling Stress  Fe,y 566.706 MPa   Eq. (3.12) 

 Factor  n 2.000    3.2.2 

 Nominal Critical Stress  Fn,y 228.781 MPa   

 Resistance Factor  FR 0.900    

 Member Resistance  Rc,y 1117.02 kN   Eq. (3.3) 

 Design Ratio  η 0.27  < 1  3.2.2 
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Lateral-torsional buckling 

Nominal and design buckling moment resistance according to [1] clause 3.3.2.2 

The nominal buckling moment resistance for lateral torsional buckling will be determined 
for this example according to Eq. (3.24), taking into account pinned supports free to warp. 
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The nominal member moment plastic resistance is determined according to clause 3.3.2.1. 

HEB-160:  The cross-section type acc. to Table 2.1 is “2 - compact”. 
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Design resistance acc. to 3.3.2.2(a) (L > Lu) 
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Interaction of biaxial bending and compression 

The design ratio is determined according to [1] clause 3.4.3.2(a). To calculate the final design 
ratio resistance acc. to Eq. (3.56), we need to determinate the value of Mm. This value can be 
calculated according to clause 3.3.2 or approximately according to Eq. (3.57) for I-sections.  
We use Eq. (3.57) in this example. 
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Interaction design ratio acc. to 3.4.3.2(a), Eq. (3.56) 

The value of Rc is the minimum design resistance in compression. 
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Result values from STEEL NTC-DF calculation 

 Yield Strength  Fy 250 MPa   1.3.1 

 Compression Axial Force  Pu 300.00 kN   

 Section Resistance  Rs 1220.63 kN   3.2 

 Elastic Buckling Stress  Fe 202.213 MPa   

 Nominal Critical Stress  Fn 157.236 MPa   

 Member Resistance  Rc 767.71 kN   Eq. (3.3) 

 Design Component for N  ηN 0.39  < 1  3.4.3.2(a) 

 Bending Moment  Muoy 3.60 kNm   

 Maximum Bending Moment  M*uoy,segm 10.00 kNm   

 Nominal Section Resistance  Mpy 88.50 kNm   

 Design Bending Resistance  MRy 79.65 kNm   

 Modulus of Elasticity  E 200000.000 MPa   

 Shear Modulus  G 77200.000 MPa   

 Second Moment of Area  Iz 8892000.000 mm4   

 Torsional Constant  J 312400.000 mm4   

 Warping Constant  Ca 4.79400E+10 mm6   

 Effective Length  Lw 4000 mm   3.3.2 

 Auxiliary Factor  Xr 0.359    Eq. (3.28) 

 Auxiliary Factor  Xu 1.157    Eq. (3.27) 

 Limit Unsupported Length  Lr 11198.700 mm   Eq. (3.26) 

 Limit Unsupported Length  Lu 3851.390 mm   Eq. (3.25) 
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 Modification Factor  Cb 1.000    

 Equivalent Moment Factor  C 1.000    3.3.2.2 

 Elastic Critical Moment  Mu 181.51 kNm   3.3.2.2 

 Design Bending Resistance  Mmy 70.23 kNm   Eq. (3.57) 

 Design Component for My  ηMy 0.142  < 1  3.4.3.2(a) 

 Bending Moment  Muoz 1.50 kNm   

 Maximum Bending Moment  M*uoz,segm 7.50 kNm   

 Nominal Section Resistance  Mpz 42.50 kNm   

 Design Bending Resistance  MRz 37.53 kNm   

 Design Component for Mz  ηMz 0.196  < 1  3.4.3.2(a) 

 Resistance Factor  FR 0.900    

 Design Ratio  η 0.73  < 1  3.4.3.2(a) 
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